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How to write the structure and ownership section of your business plan?

Business planning is vital to the success of any entrepreneur because it helps them secure funding and find competent business partners. The document itself contains a variety of key sections, including the presentation of the legal structure and ownership of the business.
This section details the legal structure of your business and helps interested parties such as lenders and investors understand who they will be doing business with if they decide to go ahead and finance your company.
In this guide, we’ll look at the objective of the structure and ownership section, deepdive into the information you should include, and cover the ideal length. We’ll also assess the tools that can help you write your business plan.
Ready? Let’s get started!
In this guide:

What is the objective of the structure and ownership section of your business plan?
What information should i include when presenting the legal structure and ownership of my company in my business plan.
	How long should the structure and ownership section of your business plan be?
	Example of structure and ownership in a business plan

What tools should I use to write my business plan?
The objective of this section is to provide potential investors, lenders, and strategic partners with a clear and transparent view of your business's legal form, ownership distribution, and registration details. 
It aims to build credibility and trust by showcasing your commitment to openness and compliance with regulations. Let's take a look at some of the key objectives:
Communicate the legal form and registration details
	You should explicitly state your business's legal form. For example, your business might be corporation, sole proprietorship, or limited liability company (LLC). 
	Clearly explaining your chosen legal form helps stakeholders understand your entity's liability, taxation, and management implications.
	It is also essential to disclose where your company is registered. This information is vital as it provides clarity on the jurisdiction under which your business operates. 
	It also helps investors and lenders assess any legal and regulatory implications specific to the location of registration.

Identify shareholders
	Potential investors and lenders need to know who owns the company and the percentage of ownership each party holds. 
	By providing this information, you instill confidence in your business and help identify what needs to be verified as part of Know Your Customer (KYC) and Anti-Money Laundering (ALM) checks down the line.

Transparency is the cornerstone of credibility for businesses. By openly presenting the legal structure and ownership, you signal to potential investors that your business operates with integrity and adherence to regulations. 
Notably, anti-money laundering regulations require investors to verify the identity of all shareholders before committing funds. By providing a clear picture of the parties involved, you can facilitate this process and build trust with investors.
Venture capitalists (VC) firms and angel investors in particular, may have specific criteria such as location and ownership mandates governing the companies they can finance. Being transparent about your company's structure and ownership enables potential investors to assess whether your business aligns with their investment preferences and requirements.
Need a convincing business plan?
The Business Plan Shop makes it easy to create a financial forecast to assess the potential profitability of your projects, and write a business plan that’ll wow investors.

The structure and ownership subsection arrives quite early in your business plan as it is the first part of the company section which is the second section of the document (after the executive summary) if you are following a standard business plan outline .
At this stage, the reader is still in the process of getting familiar with your business, and this section serves as a crucial foundation for potential investors and partners and helps them understand the core aspects of your business’s structure.
Here's what you should include:
Company registration details and registered office address
Provide information about when and where your company was registered and its registration number. This enables readers to understand the jurisdiction under which your business is operating and helps verify its legal existence.
Also, mention the registration date to showcase the company's longevity or recent establishment.
Include the registered office address of your company. This is the official address where the company can be contacted, and legal notices can be served. Providing this address demonstrates your commitment to compliance and transparency.
The information above needs to repeated for each subsidiary or joint venture owned by your business in order to provide a clear map of the coporate structure.
Overview of ownership
Offer a concise overview of the ownership structure of the company. Identify the shareholders, and specify their ownership percentages or shares. 
If there are numerous shareholders, list individuals or entities owning 5% or more, and highlight those with a controlling interest in the company or on the board.
If the business is controlled by another business, such as a holding company for example, it is also useful to explain who controls that business as well.
Roles and responsibilities of shareholders
In case of multiple shareholders, explain their respective roles and responsibilities within the organization. 
Differentiate between passive investors, board members, and executive or non-executive directors. 
Shareholders' agreement (if applicable)
If the business plan is presented for investment purposes, it is useful to clarify if a shareholders' agreement is in place between the existing investors. 
This agreement outlines the rights and obligations of shareholders and adds an extra layer of legal protection for investors and shareholders.
Expertise of co-shareholders
Highlight any shareholders who contribute more than just financial capital to the company. 
If, for instance, a shareholder is an industry expert and brings valuable advice, contacts, and credibility, emphasize this aspect. 
Doing so demonstrates the added value these shareholders bring to the business.
Group or franchise structure
If your company operates as part of a group or franchise, provide this information for each individual company receiving funds. 
Clarify the relationship between the main company and the individual entities within the group and their respective legal structures.
Addressing geographical restrictions
If some investors have geographical restrictions on their investments, clearly indicate whether your company meets their eligibility criteria. 
This helps investors quickly assess whether your business aligns with their investment mandates or not.

How long should the structure and ownership section of your business plan be? 
The length of your business plan's structure and ownership section requires a delicate balance. 
While a general rule of thumb suggests that it should be about 2 to 3 paragraphs, the actual length depends on several factors, including the complexity of your corporate structure and the number of shareholders involved.
The complexity of your corporate structure 
	A concise presentation may be sufficient if your company's legal structure is relatively straightforward, with a single owner or a small number of co-founders. 
	In such cases, aim to provide the necessary information without overwhelming the reader with unnecessary details. A paragraph or two may convey the key points effectively, ensuring clarity and brevity. 
	However, if you have a complex business structure, aim to provide details about members who play a key role in business continuity and profitability. 

The number of shareholders involved
	If your business involves multiple shareholders, each with significant ownership percentages or unique roles, you may need to dedicate more space to this section. 
	Do this by providing a comprehensive breakdown of ownership distribution and outlining each shareholder's contributions. 
	This may take up more space as you need to add additional information. However, if you have a pretty straightforward ownership structure, a paragraph or two will be sufficient enough.

Regardless of the complexity, striking the right balance between providing sufficient detail and avoiding excessive technical jargon is crucial. The structure and ownership section should be reader-friendly, allowing potential investors and stakeholders to understand the core aspects of your company without feeling overwhelmed by intricate legalities.
Repetition can dilute the impact of your message and unnecessarily lengthen the section. Ensure that you don't reiterate information that has already been covered in other parts of the business plan. Instead, focus on providing unique insights and details that enhance the reader's understanding of your corporate structure and ownership.
When crafting this section, prioritize the most critical points that investors or partners need to know about your company's structure and ownership. 
Focus on aspects that directly impact decision-making, such as the majority shareholder's influence, board composition, different classes of shares in issue, or any unique arrangements that set your business apart.
Need inspiration for your business plan?
The Business Plan Shop has dozens of business plan templates that you can use to get a clear idea of what a complete business plan looks like.

Example of structure and ownership section in a business plan 
Below is an example of what the structure and ownership section of your business plan might look like. As you can see, it is part of the overall company section and precedes the location and management team subsections.
The structure and ownership section of a business plan provides a detailed overview of how your company is organized and who holds ownership stakes in the business.

This example was taken from one of  our business plan templates .
In this section, we will review three solutions for creating a business plan for your business: using Word and Excel, hiring a consultant to write the business plan, and utilizing an online business plan software.
Create your business plan using Word and Excel
This is the old-fashioned way of creating a business plan (1990s style) and using Word and Excel has both pros and cons.
On the one hand, using either of these two programs is cheap and they are widely available. 
However, creating an error-free financial forecast with Excel is only possible if you have expertise in accounting and financial modeling.
Because of that investors and lenders might not trust the accuracy of your forecast unless you have a degree in finance or accounting.
Also, writing a business plan using Word means starting from scratch and formatting the document yourself once written - a process that can be quite tedious - especially when the numbers change and you need to manually update all the tables and text.
Ultimately, it's up to the business owner to decide which program is right for them and whether they have the expertise or resources needed to make Excel work. 
Hire a consultant to write your business plan
Outsourcing your business plan to a consultant can be a viable option, but it also presents certain drawbacks. 
On the plus side, consultants are experienced in writing business plans and adept at creating financial forecasts without errors. Furthermore, hiring a consultant can save you time and allow you to focus on the day-to-day operations of your business.
However, hiring consultants is expensive: budget at least £1.5k ($2.0k) for a complete business plan, more if you need to make changes after the initial version (which happens frequently after the first meetings with lenders).
For these reasons, outsourcing the plan to a consultant or accountant should be considered carefully, weighing both the advantages and disadvantages of hiring outside help.
Ultimately, it may be the right decision for some businesses, while others may find it beneficial to write their own business plan using an online software.
Use an online business plan software for your business plan
Another alternative is to use online business plan software .
There are several advantages to using specialized software:
	You are guided through the writing process by detailed instructions and examples for each part of the plan
	You can be inspired by already written business plan templates
	You can easily make your financial forecast by letting the software take care of the financial calculations for you without errors
	You get a professional document, formatted and ready to be sent to your bank
	The software will enable you to easily track your actual financial performance against your forecast and update your forecast as time goes by

If you're interested in using this type of solution, you can try our software for free by signing up here .
To sum it up, a well-written structure and ownership subsection is key to ensuring that the reader is clear on who controls the business, and whether or not it fits their investment criterias.
Also on The Business Plan Shop
	How to do a market analysis for a business plan
	How to present your management team in your business plan?
	Where to write the conclusion of your business plan?

Know someone who needs help writing-up their business plan? Share this article with them and help them out!

Founder & CEO at The Business Plan Shop Ltd
Guillaume Le Brouster is a seasoned entrepreneur and financier.
Guillaume has been an entrepreneur for more than a decade and has first-hand experience of starting, running, and growing a successful business.
Prior to being a business owner, Guillaume worked in investment banking and private equity, where he spent most of his time creating complex financial forecasts, writing business plans, and analysing financial statements to make financing and investment decisions.
Guillaume holds a Master's Degree in Finance from ESCP Business School and a Bachelor of Science in Business & Management from Paris Dauphine University.
Create a convincing business plan
Assess the profitability of your business idea and create a persuasive business plan to pitch to investors

500,000+ entrepreneurs have already tried our solution - why not join them?
Not ready to try our on-line tool ? Learn more about our solution here
Need some inspiration for your business plan?
Subscribe to The Business Plan Shop and gain access to our business plan template library.

Need a professional business plan? Discover our solution
Write your business plan with ease!

It's easy to create a professional business plan with The Business Plan Shop
Want to find out more before you try? Learn more about our solution here
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We’ve gathered the most useful collection of business plan PDF templates and samples, including options for organizations of any size and type.
On this page, you’ll find free PDF templates for a simple business plan , small business plan , startup business plan , and more.
Simple Business Plan PDF Templates
These simple business plan PDF templates are ready to use and customizable to fit the needs of any organization.
Simple Business Plan Template PDF

This template contains a traditional business plan layout to help you map out each aspect, from a company overview to sales projections and a marketing strategy. This template includes a table of contents, as well as space for financing details that startups looking for funding may need to provide. 
Download Simple Business Plan Template - PDF
Lean Business Plan Template PDF

This scannable business plan template allows you to easily identify the most important elements of your plan. Use this template to outline key details pertaining to your business and industry, product or service offerings, target customer segments (and channels to reach them), and to identify sources of revenue. There is also space to include key performance metrics and a timeline of activities. 
Download Lean Business Plan Template - PDF
Simple 30-60-90 Day Business Plan Template PDF

This template is designed to help you develop and implement a 90-day business plan by breaking it down into manageable chunks of time. Use the space provided to detail your main goals and deliverables for each timeframe, and then add the steps necessary to achieve your objectives. Assign task ownership and enter deadlines to ensure your plan stays on track every step of the way.
Download Simple 30-60-90 Day Business Plan Template
PDF | Smartsheet
One-Page Business Plan PDF Templates
The following single page business plan templates are designed to help you download your key ideas on paper, and can be used to create a pitch document to gain buy-in from partners, investors, and stakeholders.
One-Page Business Plan Template PDF

Use this one-page template to summarize each aspect of your business concept in a clear and concise manner. Define the who, what, why, and how of your idea, and use the space at the bottom to create a SWOT analysis (strengths, weaknesses, opportunities, and threats) for your business. 
Download One-Page Business Plan Template
If you’re looking for a specific type of analysis, check out our collection of SWOT templates .
One-Page Lean Business Plan PDF

This one-page business plan template employs the Lean management concept, and encourages you to focus on the key assumptions of your business idea. A Lean plan is not stagnant, so update it as goals and objectives change — the visual timeline at the bottom is ideal for detailing milestones. 
Download One-Page Lean Business Plan Template - PDF
One-Page 30-60-90 Day Business Plan Template

Use this business plan template to identify main goals and outline the necessary activities to achieve those goals in 30, 60, and 90-day increments. Easily customize this template to fit your needs while you track the status of each task and goal to keep your business plan on target. 
Download One-Page 30-60-90 Day Business Plan Template
For additional single page plans, including an example of a one-page business plan , visit " One-Page Business Plan Templates with a Quick How-To Guide ."
Small Business Plan PDF Templates
These business plan templates are useful for small businesses that want to map out a way to meet organizational objectives, including how to structure, operate, and expand their business.
Simple Small Business Plan Template PDF

A small business can use this template to outline each critical component of a business plan. There is space to provide details about product or service offerings, target audience, customer reach strategy, competitive advantage, and more. Plus, there is space at the bottom of the document to include a SWOT analysis. Once complete, you can use the template as a basis to build out a more elaborate plan. 
Download Simple Small Business Plan Template
Fill-In-the-Blank Small Business Plan Template PDF

This fill-in-the-blank template walks you through each section of a business plan. Build upon the fill-in-the-blank content provided in each section to add information about your company, business idea, market analysis, implementation plan, timeline of milestones, and much more.
Download Fill-In-the-Blank Small Business Plan Template - PDF
One-Page Small Business Plan Template PDF

Use this one-page template to create a scannable business plan that highlights the most essential parts of your organization’s strategy. Provide your business overview and management team details at the top, and then outline the target market, market size, competitive offerings, key objectives and success metrics, financial plan, and more.
Download One-Page Business Plan for Small Business - PDF
Startup Business Plan PDF Templates
Startups can use these business plan templates to check the feasibility of their idea, and articulate their vision to potential investors.
Startup Business Plan Template

Use this business plan template to organize and prepare each essential component of your startup plan. Outline key details relevant to your concept and organization, including your mission and vision statement, product or services offered, pricing structure, marketing strategy, financial plan, and more.
Download Startup Business Plan Template
Sample 30-60-90 Day Business Plan for Startup

Startups can use this sample 30-60-90 day plan to establish main goals and deliverables spanning a 90-day period. Customize the sample goals, deliverables, and activities provided on this template according to the needs of your business. Then, assign task owners and set due dates to help ensure your 90-day plan stays on track.
Download Sample 30-60-90 Day Business Plan for Startup Template 
For additional resources to create your plan, visit “ Free Startup Business Plan Templates and Examples .”
Nonprofit Business Plan PDF Templates
Use these business plan PDF templates to outline your organization’s mission, your plan to make a positive impact in your community, and the steps you will take to achieve your nonprofit’s goals.
Nonprofit Business Plan Template PDF

Use this customizable PDF template to develop a plan that details your organization’s purpose, objectives, and strategy. This template features a table of contents, with room to include your nonprofit’s mission and vision, key team and board members, program offerings, a market and industry analysis, promotional plan, financial plan, and more. This template also contains a visual timeline to display historic and future milestones.
Download Nonprofit Business Plan Template - PDF
One-Page Business Plan for Nonprofit Organization PDF 

This one-page plan serves as a good starting point for established and startup nonprofit organizations to jot down their fundamental goals and objectives. This template contains all the essential aspects of a business plan in a concise and scannable format, including the organizational overview, purpose, promotional plan, key objectives and success metrics, fundraising goals, and more.
Download One-Page Business Plan for Nonprofit Organization Template - PDF
Fill-In-the-Blank Business Plan PDF Templates
Use these fill-in-the-blank templates as a foundation for creating a comprehensive roadmap that aligns your business strategy with your marketing, sales, and financial goals.
Simple Fill-In-the-Blank Business Plan PDF
The fill-in-the-blank template contains all the vital parts of a business plan, with sample content that you can customize to fit your needs. There is room to include an executive summary, business description, market analysis, marketing plan, operations plan, financial statements, and more. 
Download Simple Fill-In-the-Blank Business Plan Template - PDF
Lean Fill-In-the-Blank Business Plan PDF

This business plan is designed with a Lean approach that encourages you to clarify and communicate your business idea in a clear and concise manner. This single page fill-in-the-blank template includes space to provide details about your management team, the problem you're solving, the solution, target customers, cost structure, and revenue streams. Use the timeline at the bottom to produce a visual illustration of key milestones. 
Download Fill-In-the-Blank Lean Business Plan Template - PDF
For additional resources, take a look at " Free Fill-In-the-Blank Business Plan Templates ."
Sample Business Plan PDF Templates
These sample business plan PDF templates can help you to develop an organized, thorough, and professional business plan.
Business Plan Sample 

This business plan example demonstrates a plan for a fictional food truck company. The sample includes all of the elements in a traditional business plan, which makes it a useful starting point for developing a plan specific to your business needs.
Download Basic Business Plan Sample - PDF
Sample Business Plan Outline Template

Use this sample outline as a starting point for your business plan. Shorten or expand the outline depending on your organization’s needs, and use it to develop a table of contents for your finalized plan.
Download Sample Business Plan Outline Template - PDF
Sample Business Financial Plan Template

Use this sample template to develop the financial portion of your business plan. The template provides space to include a financial overview, key assumptions, financial indicators, and business ratios. Complete the break-even analysis and add your financial statements to help prove the viability of your organization’s business plan.
Download Business Financial Plan Template
PDF  | Smartsheet
For more free, downloadable templates for all aspects of your business, check out “ Free Business Templates for Organizations of All Sizes .”
Improve Business Planning with Real-Time Work Management in Smartsheet
Empower your people to go above and beyond with a flexible platform designed to match the needs of your team — and adapt as those needs change. 
The Smartsheet platform makes it easy to plan, capture, manage, and report on work from anywhere, helping your team be more effective and get more done. Report on key metrics and get real-time visibility into work as it happens with roll-up reports, dashboards, and automated workflows built to keep your team connected and informed. 
When teams have clarity into the work getting done, there’s no telling how much more they can accomplish in the same amount of time.  Try Smartsheet for free, today.
Discover why over 90% of Fortune 100 companies trust Smartsheet to get work done.
How to Choose the Best Legal Structure for Your Business
Table of contents.

Your business’s legal structure has many ramifications. It can determine how much liability your company faces during lawsuits. It can put up a barrier between your personal and business taxes – or ensure this barrier doesn’t exist. It can also determine how often your board of directors must file paperwork – or if you even need a board. [Related article: What to Do if Your Business Gets Sued ]
We’ll explore business legal structures and how to choose the right structure for your organization. 
What is a business legal structure?
A business legal structure, also known as a business entity, is a government classification that regulates certain aspects of your business. On a federal level, your business legal structure determines your tax burden. On a state level, it can have liability ramifications.
Why is a business legal structure important?
Choosing the right business structure from the start is among the most crucial decisions you can make. Here are some factors to consider:
	Taxes: Sole proprietors, partnership owners and S corporation owners categorize their business income as personal income. C corporation income is business income separate from an owner’s personal income. Given the different tax rates for business and personal incomes, your structure choice can significantly impact your tax burden.
	Liability: Limited liability company (LLC) structures can protect your personal assets in the event of a lawsuit. That said, the federal government does not recognize LLC structures; they exist only on a state level. C corporations are a federal business structure that includes the liability protection of LLCs.
	Paperwork: Each business legal structure has unique tax forms. Additionally, if you structure your company as a corporation, you’ll need to submit articles of incorporation and regularly file certain government reports. If you start a business partnership and do business under a fictitious name, you’ll need to file special paperwork for that as well.
	Hierarchy: Corporations must have a board of directors. In certain states, this board must meet a certain number of times per year. Corporate hierarchies also prevent business closure if an owner transfers shares or exits the company, or when a founder dies . Other structures lack this closure protection.
	Registration: A business legal structure is also a prerequisite for registering your business in your state. You can’t apply for an employer identification number (EIN) or all your necessary licenses and permits without a business structure.
	Fundraising: Your structure can also block you from raising funds in certain ways. For example, sole proprietorships generally can’t offer stocks. That right is primarily reserved for corporations.
	Potential consequences for choosing the wrong structure: Your initial choice of business structure is crucial, although you can change your business structure in the future. However, changing your business structure can be a disorganized, confusing process that can lead to tax consequences and the unintended dissolution of your business. 

If you have to expand your business to another state , you won’t have to create a new company or structure, but you may have to register it as a “foreign entity.”
Types of business structures
The most common business entity types are sole proprietorships, partnerships, limited liability companies, corporations and cooperatives. Here’s more about each type of legal structure.
Sole proprietorship
A sole proprietorship is the simplest business entity. When you set up a sole proprietorship , one person is responsible for all a company’s profits and debts.
“If you want to be your own boss and run a business from home without a physical storefront, a sole proprietorship allows you to be in complete control,” said Deborah Sweeney, vice president and general manager of business acquisitions at Deluxe Corp. “This entity does not offer the separation or protection of personal and professional assets, which could prove to become an issue later on as your business grows and more aspects hold you liable.”
Proprietorship costs vary by market. Generally, early expenses will include state and federal fees, taxes, business equipment leases , office space, banking fees, and any professional services your business contracts. Some examples of these businesses are freelance writers, tutors, bookkeepers , cleaning service providers and babysitters.
A sole proprietorship business structure has several advantages.
	Easy setup: A sole proprietorship is the simplest legal structure to set up. If you – and only you – own your business, this might be the best structure. There is very little paperwork since you have no partners or executive boards.
	Low cost: Costs vary by state, but generally, license fees and business taxes are the only fees associated with a proprietorship.
	Tax deduction: Since you and your business are a single entity, you may be eligible for specific business sole proprietor tax deductions , such as a health insurance deduction.
	Easy exit: Forming a proprietorship is easy, and so is ending one. As a single owner, you can dissolve your business at any time with no formal paperwork required. For example, if you start a day care center and wish to fold the business, refrain from operating the day care and advertising your services.

The sole proprietorship is also one of the most common small business legal structures. Many famous companies started as sole proprietorships and eventually grew into multimillion-dollar businesses. These are a few examples:
	Marriott Hotels

Partnership 
A partnership is owned by two or more individuals. There are two types: a general partnership, where all is shared equally, and a limited partnership, where only one partner has control of operations and the other person (or persons) contributes to and receives part of the profits. Partnerships can operate as sole proprietorships, where there’s no separation between the partners and the business, or limited liability partnerships (LLPs), depending on the entity’s funding and liability structure.
“This entity is ideal for anyone who wants to go into business with a family member, friend or business partner – like running a restaurant or agency together,” Sweeney said. “A partnership allows the partners to share profits and losses and make decisions together within the business structure. Remember that you will be held liable for the decisions made as well as those actions made by your business partner.”
General partnership costs vary, but this structure is more expensive than a sole proprietorship because an attorney should review your partnership agreement. The attorney’s experience and location can affect the cost. 
A business partnership agreement must be a win-win for both sides to succeed. Google is an excellent example of this. In 1995, co-founders Larry Page and Sergey Brin created a small search engine and turned it into the leading global search engine. The co-founders met at Stanford University while pursuing their doctorates and later left to develop a beta version of their search engine. Soon after, they raised $1 million in funding from investors, and Google began receiving thousands of visitors a day. Having a combined ownership of 11.4% of Google provides them with a total net worth of nearly $226.4 billion.
Business partnerships have many advantages. 
	Easy formation: As with a sole proprietorship, there is little paperwork to file for a business partnership. If your state requires you to operate under a fictitious name ( “doing business as,” or DBA ), you’ll need to file a Certificate of Conducting Business as Partners and draft an Articles of Partnership agreement, both of which have additional fees. You’ll usually need a business license as well.
	Growth potential: You’re more likely to obtain a business loan with more than one owner. Bankers can consider two credit histories rather than one, which can be helpful if you have a less-than-stellar credit score.
	Special taxation: General partnerships must file federal tax Form 1065 and state returns, but they do not usually pay income tax. Both partners report their shared income or loss on their individual income tax returns. For example, if you opened a bakery with a friend and structured the business as a general partnership, you and your friend are co-owners. Each owner brings a certain level of experience and working capital to the business, affecting each partner’s business share and contribution. If you brought the most seed capital for the business, you and your partner may agree that you’ll retain a higher share percentage, making you the majority owner.

Partnerships are one of the most common business structures. These are some examples of successful partnerships:
	Warner Bros.
	Hewlett-Packard
	Ben & Jerry’s

Limited liability company 
A limited liability company (LLC) is a hybrid structure that allows owners, partners or shareholders to limit their personal liabilities while enjoying a partnership’s tax and flexibility benefits. Under an LLC, members are shielded from personal liability for the business’s debts if it can’t be proven that they acted in a negligent or wrongful manner that results in injury to another in carrying out the activities of the business.
“Limited liability companies were created to provide business owners with the liability protection that corporations enjoy while allowing earnings and losses to pass through to the owners as income on their personal tax returns,” said Brian Cairns, CEO of ProStrategix Consulting. “LLCs can have one or more members, and profits and losses do not have to be divided equally among members.”
According to Wolters Kluwer , the cost of forming an LLC comprises the state filing fee and can vary depending on your state. For example, if you file an LLC in New York, you must pay a $200 filing fee, a $9 biennial fee, and file a biennial statement with the New York Department of State .
Although small businesses can be LLCs, some large businesses choose this legal structure. The structure is typical among accounting, tax, and law firms, but other types of companies also file as LLCs. One example of an LLC is Anheuser-Busch, one of the leaders in the U.S. beer industry. Headquartered in St. Louis, Anheuser-Busch is a wholly owned subsidiary of Anheuser-Busch InBev, a multinational brewing company based in Leuven, Belgium.
Here some other well-known examples of LLCs:
	Hertz Rent-a-Car

To learn more about LLCs, read our LLC tax guide , our comprehensive overview of starting an LLC , and our guide to creating an LLC operating agreement.
Corporation 
The law regards a corporation as separate from its owners, with legal rights independent of its owners. It can sue, be sued, own and sell property, and sell the rights of ownership in the form of stocks. Corporation filing fees vary by state and fee category. 
There are several types of corporations, including C corporations , S corporations, B corporations, closed corporations, and nonprofit corporations.
	C corporations: C corporations, owned by shareholders, are taxed as separate entities. JPMorgan Chase & Co. is a multinational investment bank and financial services holding company listed as a C corporation. Since C corporations allow an unlimited number of investors, many larger companies – including Apple, Bank of America and Amazon – file for this tax status.
	B corporations: B corporations, otherwise known as benefit corporations, are for-profit entities committed to corporate social responsibility and structured to positively impact society. For example, skincare and cosmetics company The Body Shop has proven its long-term commitment to supporting environmental and social movements, resulting in an awarded B corporation status. The Body Shop uses its presence to advocate for permanent change on issues like human trafficking, domestic violence, climate change, deforestation and animal testing in the cosmetic industry.
	Closed corporations: Closed corporations, typically run by a few shareholders, are not publicly traded and benefit from limited liability protection. Closed corporations, sometimes referred to as privately held companies, have more flexibility than publicly traded companies. For example, Hobby Lobby is a closed corporation – a privately held, family-owned business. Stocks associated with Hobby Lobby are not publicly traded; instead, the stocks have been allocated to family members.
	Open corporations: Open corporations are available for trade on a public market. Many well-known companies, including Microsoft and Ford Motor Co., are open corporations. Each corporation has taken ownership of the company and allows anyone to invest.
	Nonprofit corporations: Nonprofit corporations exist to help others in some way and are rewarded by tax exemption. Some examples of nonprofits are the Salvation Army, American Heart Association and American Red Cross. These organizations all focus on something other than turning a profit.

Corporations enjoy several advantages. 
	Limited liability: Stockholders are not personally liable for claims against your corporation; they are liable only for their personal investments.
	Continuity: Corporations are not affected by death or the transferring of shares by their owners. Your business continues to operate indefinitely, which investors, creditors and consumers prefer.
	Capital: It’s much easier to raise large amounts of capital from multiple investors when your business is incorporated.

This structure is ideal for businesses that are further along in their growth, rather than a startup based in a living room. For example, if you’ve started a shoe company and have already named your business, appointed directors and raised capital through shareholders, the next step is to become incorporated. You’re essentially conducting business at a riskier, yet more lucrative, rate. Additionally, your business could file as an S corporation for the tax benefits. Once your business grows to a certain level, it’s likely in your best interest to incorporate it.
These are some popular examples of corporations:
	General Motors
	Exxon Mobil Corp.
	Domino’s Pizza
	JPMorgan Chase

Learn more about how to become a corporation .
Cooperative 
A cooperative (co-op) is owned by the same people it serves. Its offerings benefit the company’s members, also called user-owners, who vote on the organization’s mission and direction and share profits.
Cooperatives offer a couple main advantages.
	Increased funding: Cooperatives may be eligible for federal grants to help them get started.
	Discounts and better service: Cooperatives can leverage their business size, thus obtaining discounts on products and services for their members.

Forming a cooperative is complex and requires you to choose a business name that indicates whether the co-op is a corporation (e.g., Inc. or Ltd.). The filing fee associated with a co-op agreement varies by state. 
An example of a co-op is CHS Inc., a Fortune 100 business owned by U.S. agricultural cooperatives. As the nation’s leading agribusiness cooperative, CHS reported a net income of $422.4 million for fiscal year 2020. These are some other notable examples of co-ops:
	Land O’Lakes
	Navy Federal Credit Union
	Ace Hardware

The five types of business structures are sole proprietorship, partnership, limited liability company, corporation and cooperative. The right structure depends mainly on your business type.
Factors to consider before choosing a business structure
For new businesses that could fall into two or more of these categories, it’s not always easy to decide which structure to choose. Consider your startup’s financial needs, risk and ability to grow. It can be challenging to switch your legal structure after registering your business, so give it careful analysis in the early stages of forming your business. 
Here are some crucial factors to consider as you choose your business’s legal structure. You should also consult a CPA for advice.
Flexibility 
Where is your company headed, and which type of legal structure allows for the growth you envision? Turn to your business plan to review your goals and see which structure best aligns with those objectives. Your entity should support the possibility for growth and change, not hold it back from its potential. [Learn how to write a business plan with this template .]
When it comes to startup and operational complexity, nothing is more straightforward than a sole proprietorship. Register your name, start doing business, report the profits and pay taxes on it as personal income. However, it can be difficult to procure outside funding. Partnerships, on the other hand, require a signed agreement to define the roles and percentages of profits. Corporations and LLCs have various reporting requirements with state governments and the federal government.
A corporation carries the least amount of personal liability since the law holds that it is its own entity. This means creditors and customers can sue the corporation, but they can’t gain access to any personal assets of the officers or shareholders. An LLC offers the same protection but with the tax benefits of a sole proprietorship. Partnerships share the liability between the partners as defined by their partnership agreement.
An owner of an LLC pays taxes just as a sole proprietor does: All profit is considered personal income and taxed accordingly at the end of the year.
“As a small business owner, you want to avoid double taxation in the early stages,” said Jennifer Friedman, principal at Rivetr. “The LLC structure prevents that and makes sure you’re not taxed as a company, but as an individual.”
Individuals in a partnership also claim their share of the profits as personal income. Your accountant may suggest quarterly or biannual advance payments to minimize the effect on your return. 
A corporation files its own tax returns each year, paying taxes on profits after expenses, including payroll. If you pay yourself from the corporation, you will pay personal taxes, such as those for Social Security and Medicare, on your personal return. 
To simplify payroll complexities and taxation issues, consider using a payroll service. Check out our reviews of the best payroll services to find a partner that fits your needs and budget.
If you want sole or primary control of the business and its activities, a sole proprietorship or an LLC might be the best choice. You can negotiate such control in a partnership agreement as well.
A corporation is constructed to have a board of directors that makes the major decisions that guide the company. A single person can control a corporation, especially at its inception, but as it grows, so does the need to operate it as a board-directed entity. Even for a small corporation, the rules intended for larger organizations – such as keeping notes of every major decision that affects the company – still apply.
Capital investment
If you need to obtain outside funding from an investor, venture capitalist or bank, you may be better off establishing a corporation. Corporations have an easier time obtaining outside funding than sole proprietorships.
Corporations can sell shares of stock and secure additional funding for growth, while sole proprietors can obtain funds only through their personal accounts, using their personal credit or taking on partners. An LLC can face similar struggles, although, as its own entity, it’s not always necessary for the owner to use their personal credit or assets.
Licenses, permits and regulations
In addition to legally registering your business entity, you may need specific licenses and permits to operate. Depending on the type of business and its activities, it may need to be licensed at the local, state and federal levels.
“States have different requirements for different business structures,” Friedman said. “Depending on where you set up, there could be different requirements at the municipal level as well. As you choose your structure, understand the state and industry you’re in. It’s not ‘one size fits all,’ and businesses may not be aware of what’s applicable to them.”
The structures discussed here apply only to for-profit businesses. If you’ve done your research and you’re still unsure which business structure is right for you, Friedman advises speaking with a specialist in business law.
Max Freedman and Matt D’Angelo contributed to the writing and reporting in this article. Source interviews were conducted for a previous version of this article.
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This Practice Note provides information for law firms about preparing and implementing a successful business plan .
What is a business plan?
A business plan is a document that explains how the firm will achieve its objectives—see Precedents: Strategic business plan— consumer and Strategic business plan—commercial.
Why have a business plan?
Business planning confers several benefits to the firm, eg:
increasing the likelihood of achieving the firm’s objectives
demonstrating to others, eg banks, that the firm is moving forward
keeping management and staff focused
increasing the likelihood of recruiting and retaining talented staff
increasing profitability
Business planning is a key consideration when starting a new business. However, all firms should think of business planning as an evolving process which should be reviewed regularly to measure progress and encourage others to invest time and effort in the business.
Who should write the plan?
Traditionally and most commonly, the management and owners of the firm are the authors of the business plan. The firm’s compliance officer for finance and administration (COFA) will usually
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The legal form of organization in business plan is used to decide how the organization will function, how roles will be arranged and assigned, and how relationships will work. These organizational steps should take place at the beginning of the business formation.
Starting a Business
The first step when beginning a business is to name the business. The name must be unique and not in use by another existing entity. The next step is to decide on the organization type your business will use. Each business entity has specific requirements on how they are run including how income is reported. The business types include:
	Sole proprietorship.
	Partnership.
	Limited Liability Company.
	Limited Liability Partnership.
	Corporation.
	S Corporation.
	Tax-exempt organization.

Each type has advantages and disadvantages that should be reviewed before making a final decision. However, the business type you choose isn't permanent. As the needs of your business change, the business entity type can be changed. Examples include:
	Changing a sole proprietorship to a partnership due to growth.
	Switching to a corporation to establish protection that comes with limited liability.

Limited Liability is attractive to business owners because it protects personal assets from any debts or obligations incurred by the corporation.

Business Type Requirements
A major component of selecting a business type is what is required to be legal and the tax implications.
	Applications to the state government are not required.
	Dependent on the state, registering the business may be required with the state and/or country.
	A business license may be required based on the type of business and state requirements.
	The IRS views all business activity as personal. When filing, personal and business income are seen as the same thing.
	A sole proprietorship is personally responsible for all aspects of the business. If the business is sold, it can impact any personal assets if you are found liable.
	In a general partnership, two or more sole proprietors are seen by the IRS as having equal responsibility.
	Any profit and loss distribution is determined by the partnership agreement and is then passed to the individual partners.
	Profit and loss distribution does not have to match the percentage of ownership.
	The partnership is not subject to income or franchise tax.
	The structure and tax implications are similar to a general partnership, but a limited partnership ( silent partner ) allows for ownership without the requirement of being actively involved in how the business is managed.
	Business liabilities are limited to the amount invested by the partner.
	Outside investors can be partners without taking on any liabilities.
	Personal liability protection is provided without having to meet the administrative and governance procedures.
	The Articles of Organization determine the ownership percentages, distribution of profit and losses, and voting rights. In corporations, this is determined by stock ownership.
	Most LLCs use the pass-through method of taxation. This means that taxes aren't paid by the LLC, but by at the personal tax level of the owners. The personal rate is lower than the corporate tax rate. When the LLC files taxes, no money is sent and an owners report is included to show the owners will pay the tax instead.
	Based on the state, the LLC is subject to a franchise tax .
	A corporation can be formed as for-profit or nonprofit.
	Corporations provide a shield from liabilities. This protection is only removed if the owners or board members have been found to be illegally running a corporation and have been breaking federal and/or state laws.
	Corporations can sell stock in the business.
	A Board of Directors is used to manage corporate policies and strategies. This is for both for-profit and nonprofit.
	Corporations continue to exist even in the event of the owner's death, or if owners leave.

If you need help with the legal form of organization in the business plan, you can post your legal need on UpCounsel's marketplace. UpCounsel accepts only the top 5 percent of lawyers to its site. Lawyers on UpCounsel come from law schools such as Harvard Law and Yale Law and average 14 years of legal experience, including work with or on behalf of companies like Google, Menlo Ventures, and Airbnb.
Hire the top business lawyers and save up to 60% on legal fees
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How to Write Your Law Firm Business Plan

By Cari Twitchell
News Articles Healthy Strategy
Every new law practice needs a business plan . This is a guide to creating one.
Here is what should go in your business plan once you’ve decided about your law firm business model.
Section One: Executive Summary
This section provides a succinct overview of your full plan. It should also include the following:
	Mission statement.  This statement should be one or two sentences at most, so you can quickly state it off the top of your head at any given moment. It should clearly state your value and offer inspiration and guidance, while being plausible and specific enough to ensure relevancy. For further direction on how to write a mission statement, read this Entrepreneur article .
	Core values.  Your core values outline the strategy that underpins your business. When written well, they help potential employees and clients understand what drives you every day. When written incorrectly, they include meaningless platitudes that become yet another thing forgotten or ignored during practice. To pack the most punch into your core values, write them as actionable statements that you can follow. And keep them to a minimum: two to four should do just fine. You can read more about writing core values at  Kinesis .
	What sets you apart.  If you are like every other attorney out there, how will you stand out? This is known as your unique selling proposition (USP). What is it that will convince clients to turn to you instead of your competition? By clearly stating your USP, you identify what it is about your firm that will ensure your success.

Are you feeling slightly overwhelmed by all of this? Then write this section last, as you’ll find much of what you write here is a summary of everything you include in subsequent sections.
Section Two: Company Description
Write a succinct overview of your company. Here is what it should cover:
	Mission statement and values.  Reiterate your mission statement and core values here.
	Geographic location and areas served.  Identify where your offices are located and the geographic areas that you serve.
	Legal structure and ownership. State whether you are an LLC, S-Corp or other legal entity. If you are something other than a sole proprietor, identify the ownership structure of your firm. How does your law firm business model influence the ownership type?
	Firm history.  If you are writing or updating a plan for a law firm already in existence, write a brief history that summarizes firm highlights and achievements.

This section is often the shortest. Do not spend much time or space here. Touch on the major points and move on.
Section Three: Market Analysis
Done correctly, a well thought out market analysis will help you identify exactly what your potential clients are looking for and how much you should charge for your services. It also enables you to identify your competitors’ weaknesses, which in turn helps you best frame your services in a way that attracts your preferred clientele. You probably already considered some of these subjects when deciding on the small law firm business model, but you need to document them.
Elements of a market analysis include:
	Industry description.  Draft up a summary that encompasses where your particular legal niche is today, where it has been, and which trends will likely affect it in the future. Identify everything from actual market size to project market growth.
	Target audience.  Define your target audience by building your ideal client persona. Use demographics such as location, age, family status, occupation and more. Map out the motivations behind their seeking your services and then how it is you are best able to satisfy their requirements.
	Competitive analysis.  This is where you dive into details about your competitors. What do they do well? Where do they fall short? How are they currently underserving your target market? What challenges do you face by entering legal practice in your field of choice?
	Projections.  Provide specific data on how much your target audience has to spend. Then narrow that down to identify how much you can charge per service.

A proper market analysis includes actual data to support your analysis. If you are unsure of where to find data, Bplans  has a great list of resources for you to use. And if you would like to read further about conducting a market analysis, check out this article from the Small Business Administration.
Section Four: Organization & Management
This section goes into detail about you and any others who may have ownership interest in the firm. The small law firm business model section here should incorporated into the management documentation. Do not be afraid to brag a bit!
	What is your educational background?
	What experience do you currently have?
	Why are you the right person to run your firm?

If there are other individuals involved, it is a good idea to insert your organizational chart here. Visuals help quickly convey information and break up otherwise blocky text.
Section Five: Services
The Services section is the heart of your law firm business model plan. It is where you dive into all aspects of your services, including:
	The problem(s) you are addressing.  What pain points do your preferred clients experience? What can they do right now to alleviate those pain points? Answer these questions, and then take the extra step to explain how those current solutions fail to adequately address their problems.
	The solution(s) you are providing.  This describes how your solutions better resolve your prospective market’s needs. This not only includes the actual work you do, but the benefits that each client will receive based on your work.
	An overview of your competition.  Describe your competition here. For instance, which other solo attorneys and firms provide the same solutions as you? What are your advantages over these competitors? What do you differently when providing your solutions? How will clients gain additional benefits by seeking out your services instead of working with your competitors?

Section 6: Marketing Strategy
Your marketing strategy section needs to address the three P’s:
	Positioning.  How will you position your law firm and your services? What will you say to present your practice in the best light? What short statements can you use to entice a potential client to pursue your services?
	Pricing.  How much will you charge? How does that fit within the legal industry? Within your niche industry? What do clients receive for that price?
	Promotion.  Which sales channels and marketing activities will you pursue to promote your practice? Who is in charge of these activities? Even if you plan to build your law firm on the basis of word-of-mouth referrals, you must remember that most referrals will still look for information about you before contacting you. Know where they will look and ensure you are there.

Section Seven: Financials
Last comes the financials section. It is the key component to your plan if you are going to seek funding to get your practice off the ground. It is imperative that you complete this section even if you are not seeking funding, however, as you need to paint a clear financial picture before opening your doors.
Two main items make up this section: budgeting and forecasting (sales and cash flow). Answer these questions to help you address these items:
	How much starting capital do you need?
	How much money will it cost to keep your practice operating on a month-to-month basis?
	How many cases will you need to close each month to break even?
	How many cases would you need to close to make a profit?
	What is your projected profit and loss for the year?

This section often incorporates graphs and other images, including profit-and-loss and cash-flow tables. The more specific you get with your numbers, the more likely you are to succeed!
One final note: If your goal is to submit your business plan to potential funders, you want to do everything you can to make sure your plan stands out. One good way to do this is to work with a designer to artfully format your plan. Great presentation can take you a long way.
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Law Firm Business Plan Template
Written by Dave Lavinsky

Law Firm Plan
Over the past 20+ years, we have helped over 1,000 lawyers to create business plans to start and grow their law firms. On this page, we will first give you some background information with regards to the importance of business planning. We will then go through a law firm business plan template step-by-step so you can create your plan today.
Download our Ultimate Business Plan Template here >
What Is a Business Plan?
A business plan provides a snapshot of your law firm as it stands today, and lays out your growth plan for the next five years. It explains your business goals and your strategy for reaching them. It also includes market research to support your plans.
Why You Need a Business Plan
If you’re looking to start a law firm, or grow your existing law firm, you need a business plan. A business plan will help you raise funding, if needed, and plan out the growth of your law firm in order to improve your chances of success. Your law firm plan is a living document that should be updated annually as your company grows and changes.
Sources of Funding for Law Firms
With regards to funding, the main sources of funding for a law firm are personal savings, credit cards and bank loans. With regards to bank loans, banks will want to review your business plan and gain confidence that you will be able to repay your loan and interest. To acquire this confidence, the loan officer will not only want to confirm that your financials are reasonable, but they will also want to see a professional plan. Such a plan will give them the confidence that you can successfully and professionally operate a business.
Finish Your Business Plan Today!
How to write a business plan for a law firm.
If you want to start a law firm or expand your current one, you need a business plan. Below are links to each section of your law firm plan template:
Executive Summary
Your executive summary provides an introduction to your business plan, but it is normally the last section you write because it provides a summary of each key section of your plan.
The goal of your Executive Summary is to quickly engage the reader. Explain to them the type of law firm you are operating and the status. For example, are you a startup, do you have a law firm that you would like to grow, or are you operating law firms in multiple cities?
Next, provide an overview of each of the subsequent sections of your plan. For example, give a brief overview of the law firm industry. Discuss the type of law firm you are operating. Detail your direct competitors. Give an overview of your target customers. Provide a snapshot of your marketing plan. Identify the key members of your team. And offer an overview of your financial plan.  
Company Analysis
In your company analysis, you will detail the type of law firm you are operating.
For example, you might operate one of the following types of law firms:
	Commercial Law : this type of law firm focuses on financial matters such as merger and acquisition, raising capital, IPOs, etc.
	Criminal, Civil Negligence, and Personal Injury Law: this type of business focuses on accidents, malpractice, and criminal defense.
	Real Estate Law: this type of practice deals with property transactions and property use.
	Labor Law: this type of firm handles everything related to employment, from pensions/benefits, to contract negotiation.

In addition to explaining the type of law firm you will operate, the Company Analysis section of your business plan needs to provide background on the business.
Include answers to question such as:
	When and why did you start the business?
	What milestones have you achieved to date? Milestones could include the number of clients served, number of cases won, etc.
	Your legal structure. Are you incorporated as an S-Corp? An LLC? A sole proprietorship? Explain your legal structure here.

Industry Analysis
In your industry analysis, you need to provide an overview of the law firm industry.
While this may seem unnecessary, it serves multiple purposes.
First, researching the law firm industry educates you. It helps you understand the market in which you are operating.
Secondly, market research can improve your strategy, particularly if your research identifies market trends.
The third reason for market research is to prove to readers that you are an expert in your industry. By conducting the research and presenting it in your plan, you achieve just that.
The following questions should be answered in the industry analysis section of your law firm plan:
	How big is the law firm industry (in dollars)?
	Is the market declining or increasing?
	Who are the key competitors in the market?
	Who are the key suppliers in the market?
	What trends are affecting the industry?
	What is the industry’s growth forecast over the next 5 – 10 years?
	What is the relevant market size? That is, how big is the potential market for your law firm? You can extrapolate such a figure by assessing the size of the market in the entire country and then applying that figure to your local population.

Customer Analysis
The customer analysis section of your law firm plan must detail the customers you serve and/or expect to serve.
The following are examples of customer segments: businesses, households, and government organizations.
As you can imagine, the customer segment(s) you choose will have a great impact on the type of law firm you operate. Clearly, households would respond to different marketing promotions than nonprofit organizations, for example.
Try to break out your target customers in terms of their demographic and psychographic profiles. With regards to demographics, include a discussion of the ages, genders, locations and income levels of the customers you seek to serve. Because most law firms primarily serve customers living in their same city or town, such demographic information is easy to find on government websites.
Psychographic profiles explain the wants and needs of your target customers. The more you can understand and define these needs, the better you will do in attracting and retaining your customers.
Finish Your Law Firm Business Plan in 1 Day!
Don’t you wish there was a faster, easier way to finish your business plan?
With Growthink’s Ultimate Business Plan Template you can finish your plan in just 8 hours or less!
Competitive Analysis
Your competitive analysis should identify the indirect and direct competitors your business faces and then focus on the latter.
Direct competitors are other law firms.
Indirect competitors are other options that customers have to purchase from that aren’t direct competitors. This includes accounting firms or human resources companies. You need to mention such competition as well.
With regards to direct competition, you want to describe the other law firms with which you compete. Most likely, your direct competitors will be law firms located very close to your location.
For each such competitor, provide an overview of their businesses and document their strengths and weaknesses. Unless you once worked at your competitors’ businesses, it will be impossible to know everything about them. But you should be able to find out key things about them such as:
	What types of customers do they serve?
	What types of cases do they accept?
	What is their pricing (premium, low, etc.)?
	What are they good at?
	What are their weaknesses?

With regards to the last two questions, think about your answers from the customers’ perspective. And don’t be afraid to ask your competitors’ customers what they like most and least about them.
The final part of your competitive analysis section is to document your areas of competitive advantage. For example:
	Will you provide better legal advice and services?
	Will you provide services that your competitors don’t offer?
	Will you provide more responsive customer interactions?
	Will you offer better pricing or flexible pricing options?

Think about ways you will outperform your competition and document them in this section of your plan.  
Marketing Plan
Traditionally, a marketing plan includes the four P’s: Product, Price, Place, and Promotion. For a law firm plan, your marketing plan should include the following:
Product : In the product section, you should reiterate the type of law firm company that you documented in your Company Analysis. Then, detail the specific products you will be offering. For example, in addition to in-person consultation, will you provide virtual meetings, or any other services?
Price : Document the prices you will offer and how they compare to your competitors. Essentially in the product and price sub-sections of your marketing plan, you are presenting the products and services you offer and their prices.
Place : Place refers to the location of your law firm company. Document your location and mention how the location will impact your success. For example, is your law firm located in a busy business district, office building, etc. Discuss how your location might be the ideal location for your customers.
Promotions : The final part of your law firm marketing plan is the promotions section. Here you will document how you will drive customers to your location(s). The following are some promotional methods you might consider:
	Advertising in local papers and magazines
	Reaching out to local websites
	Social media marketing
	Local radio advertising

Operations Plan
While the earlier sections of your business plan explained your goals, your operations plan describes how you will meet them. Your operations plan should have two distinct sections as follows.
Everyday short-term processes include all of the tasks involved in running your law firm, including filling and filing paperwork, researching precedents, appearing in court, meeting with clients, etc.
Long-term goals are the milestones you hope to achieve. These could include the dates when you expect to file your 100th lawsuit, or be on retainer with 25 business clients, or when you hope to reach $X in revenue. It could also be when you expect to expand your law firm to a new city.  
Management Team
To demonstrate your law firm’ ability to succeed, a strong management team is essential. Highlight your key players’ backgrounds, emphasizing those skills and experiences that prove their ability to grow a company.
Ideally you and/or your team members have direct experience in managing law firms. If so, highlight this experience and expertise. But also highlight any experience that you think will help your business succeed.
If your team is lacking, consider assembling an advisory board. An advisory board would include 2 to 8 individuals who would act like mentors to your business. They would help answer questions and provide strategic guidance. If needed, look for advisory board members with legal experience or with a track record of successfully running small businesses.  
Financial Plan
Your financial plan should include your 5-year financial statement broken out both monthly or quarterly for the first year and then annually. Your financial statements include your income statement, balance sheet and cash flow statements.
Income Statement : an income statement is more commonly called a Profit and Loss statement or P&L. It shows your revenues and then subtracts your costs to show whether you turned a profit or not.
In developing your income statement, you need to devise assumptions. For example, will you file 25 lawsuits per month or sign 5 retainer contracts per month? And will sales grow by 2% or 10% per year? As you can imagine, your choice of assumptions will greatly impact the financial forecasts for your business. As much as possible, conduct research to try to root your assumptions in reality.
Balance Sheets : Balance sheets show your assets and liabilities. While balance sheets can include much information, try to simplify them to the key items you need to know about. For instance, if you spend $50,000 on building out your law firm, this will not give you immediate profits. Rather it is an asset that will hopefully help you generate profits for years to come. Likewise, if a bank writes you a check for $50,000, you don’t need to pay it back immediately. Rather, that is a liability you will pay back over time.
Cash Flow Statement : Your cash flow statement will help determine how much money you need to start or grow your business, and make sure you never run out of money. What most entrepreneurs and business owners don’t realize is that you can turn a profit but run out of money and go bankrupt.
In developing your Income Statement and Balance Sheets be sure to include several of the key costs needed in starting or growing a law firm:
	Location build-out including design fees, construction, etc.
	Cost of licensing, software, and office supplies
	Payroll or salaries paid to staff
	Business insurance
	Taxes and permits
	Legal expenses

Attach your full financial projections in the appendix of your plan along with any supporting documents that make your plan more compelling. For example, you might include your office location lease or your certificate of admission to the bar.  
Putting together a business plan for your law firm is a worthwhile endeavor. If you follow the template above, by the time you are done, you will truly be an expert and know everything you need about starting a law firm business plan; once you create your plan, download it to PDF to show banks and investors. You will really understand the law firm industry, your competition, and your customers. You will have developed a marketing plan and will really understand what it takes to launch and grow a successful law firm.  
Law Firm Business Plan FAQs
What is the easiest way to complete my law firm business plan.
Growthink's Ultimate Business Plan Template allows you to quickly and easily complete your Law Firm Business Plan.
What is the Goal of a Business Plan's Executive Summary?
The goal of your Executive Summary is to quickly engage the reader. Explain to them the type of law firm you are operating and the status; for example, are you a startup, do you have a law firm that you would like to grow, or are you operating a chain of law firms?
Don’t you wish there was a faster, easier way to finish your Law Firm business plan?
OR, Let Us Develop Your Plan For You
Since 1999, Growthink has developed business plans for thousands of companies who have gone on to achieve tremendous success.   Click here to see how Growthink’s professional business plan consulting services can create your business plan for you.
Other Helpful Business Plan Articles & Templates

At the end of your visit today, would you complete a short survey to help improve our services?
Thanks! When you're ready, just click "Start survey".
It looks like you’re about to finish your visit. Are you ready to start the short survey now?
Waterway works and structures
Approvals, guidelines and processes for works and structures in Queensland waterways.
Waterway barrier works
Accepted development requirements and approvals for waterway barrier works.
Waterways in Queensland
Attributes and locations of waterways in Queensland.
Fish movement and passage
Avoid blocking fish movement when carrying out works in waterways.
Freshwater fish habitat
Types of habitats and how to protect them.
Fish salvage
Guidelines and approvals for carrying out fish salvage.
Fish-friendly structures
Design requirements and guidelines when building structures in fish habitats.
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Create a form in Word that users can complete or print
In Word, you can create a form that others can fill out and save or print.  To do this, you will start with baseline content in a document, potentially via a form template.  Then you can add content controls for elements such as check boxes, text boxes, date pickers, and drop-down lists. Optionally, these content controls can be linked to database information.  Following are the recommended action steps in sequence.  
Show the Developer tab
In Word, be sure you have the Developer tab displayed in the ribbon.  (See how here:  Show the developer tab .)
Open a template or a blank document on which to base the form
You can start with a template or just start from scratch with a blank document.
Start with a form template
Go to File > New .
In the  Search for online templates  field, type  Forms or the kind of form you want. Then press Enter .
In the displayed results, right-click any item, then select  Create. 
Start with a blank document 
Select Blank document .
Add content to the form
Go to the  Developer  tab Controls section where you can choose controls to add to your document or form. Hover over any icon therein to see what control type it represents. The various control types are described below. You can set properties on a control once it has been inserted.
To delete a content control, right-click it, then select Remove content control  in the pop-up menu. 
Note:  You can print a form that was created via content controls. However, the boxes around the content controls will not print.
Insert a text control
The rich text content control enables users to format text (e.g., bold, italic) and type multiple paragraphs. To limit these capabilities, use the plain text content control . 
Click or tap where you want to insert the control.

To learn about setting specific properties on these controls, see Set or change properties for content controls .
Insert a picture control
A picture control is most often used for templates, but you can also add a picture control to a form.

Insert a building block control
Use a building block control  when you want users to choose a specific block of text. These are helpful when you need to add different boilerplate text depending on the document's specific purpose. You can create rich text content controls for each version of the boilerplate text, and then use a building block control as the container for the rich text content controls.

Select Developer and content controls for the building block.

Insert a combo box or a drop-down list
In a combo box, users can select from a list of choices that you provide or they can type in their own information. In a drop-down list, users can only select from the list of choices.

Select the content control, and then select Properties .
To create a list of choices, select Add under Drop-Down List Properties .
Type a choice in Display Name , such as Yes , No , or Maybe .
Repeat this step until all of the choices are in the drop-down list.
Fill in any other properties that you want.
Note:  If you select the Contents cannot be edited check box, users won’t be able to click a choice.
Insert a date picker
Click or tap where you want to insert the date picker control.

Insert a check box
Click or tap where you want to insert the check box control.

Use the legacy form controls
Legacy form controls are for compatibility with older versions of Word and consist of legacy form and Active X controls.
Click or tap where you want to insert a legacy control.

Select the Legacy Form control or Active X Control that you want to include.
Set or change properties for content controls
Each content control has properties that you can set or change. For example, the Date Picker control offers options for the format you want to use to display the date.
Select the content control that you want to change.
Go to Developer > Properties .

Change the properties that you want.
Add protection to a form
If you want to limit how much others can edit or format a form, use the Restrict Editing command:
Open the form that you want to lock or protect.
Select Developer > Restrict Editing .

After selecting restrictions, select Yes, Start Enforcing Protection .

Advanced Tip:
If you want to protect only parts of the document, separate the document into sections and only protect the sections you want.
To do this, choose Select Sections in the Restrict Editing panel. For more info on sections, see Insert a section break .

If the developer tab isn't displayed in the ribbon, see Show the Developer tab .
Open a template or use a blank document
To create a form in Word that others can fill out, start with a template or document and add content controls. Content controls include things like check boxes, text boxes, and drop-down lists. If you’re familiar with databases, these content controls can even be linked to data.
Go to File > New from Template .

In Search, type form .
Double-click the template you want to use.
Select File > Save As , and pick a location to save the form.
In Save As , type a file name and then select Save .
Start with a blank document
Go to File > New Document .

Go to File > Save As .
Go to Developer , and then choose the controls that you want to add to the document or form. To remove a content control, select the control and press Delete. You can set Options on controls once inserted. From Options, you can add entry and exit macros to run when users interact with the controls, as well as list items for combo boxes, .
Adding content controls to your form
In the document, click or tap where you want to add a content control.
On Developer , select Text Box , Check Box , or Combo Box .

To set specific properties for the control, select Options , and set .
Repeat steps 1 through 3 for each control that you want to add.
Set options
Options let you set common settings, as well as control specific settings. Select a control and then select Options to set up or make changes.
Set common properties.
Select Macro to Run on lets you choose a recorded or custom macro to run on Entry or Exit from the field.
Bookmark Set a unique name or bookmark for each control.
Calculate on exit This forces Word to run or refresh any calculations, such as total price when the user exits the field.
Add Help Text Give hints or instructions for each field.
OK Saves settings and exits the panel.
Cancel Forgets changes and exits the panel.
Set specific properties for a Text box
Type Select form Regular text, Number, Date, Current Date, Current Time, or Calculation.
Default text sets optional instructional text that's displayed in the text box before the user types in the field. Set Text box enabled to allow the user to enter text into the field.
Maximum length sets the length of text that a user can enter. The default is Unlimited .
Text format can set whether text automatically formats to Uppercase , Lowercase , First capital, or Title case .
Text box enabled Lets the user enter text into a field. If there is default text, user text replaces it.
Set specific properties for a Check box .
Default Value Choose between Not checked or checked as default.
Checkbox size Set a size Exactly or Auto to change size as needed.
Check box enabled Lets the user check or clear the text box.
Set specific properties for a Combo box
Drop-down item Type in strings for the list box items. Press + or Enter to add an item to the list.
Items in drop-down list Shows your current list. Select an item and use the up or down arrows to change the order, Press - to remove a selected item.
Drop-down enabled Lets the user open the combo box and make selections.
Protect the form
Go to Developer > Protect Form .

Note:  To unprotect the form and continue editing, select Protect Form again.
Save and close the form.
Test the form (optional)
If you want, you can test the form before you distribute it.
Protect the form.
Reopen the form, fill it out as the user would, and then save a copy.
Creating fillable forms isn’t available in Word for the web.
You can create the form with the desktop version of Word with the instructions in Create a fillable form .
When you save the document and reopen it in Word for the web, you’ll see the changes you made.

Need more help?
Want more options.
Explore subscription benefits, browse training courses, learn how to secure your device, and more.

Microsoft 365 subscription benefits

Microsoft 365 training

Microsoft security

Accessibility center
Communities help you ask and answer questions, give feedback, and hear from experts with rich knowledge.

Ask the Microsoft Community

Microsoft Tech Community

Windows Insiders
Microsoft 365 Insiders
Was this information helpful?
Thank you for your feedback.
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	Write your business plan
Executive summary Briefly tell your reader what your company is and why it will be successful. Include your mission statement, your product or service, and basic information about your company's leadership team, employees, and location. You should also include financial information and high-level growth plans if you plan to ask for financing.




	PDF Legal Structures for Business Organizations
Characteristics. Compared to other structures it is the simplest to use. Does not require government approval. The business has no existence apart from the owner. The owner is his or her own boss. Characteristics. The owner owns the business assets. The owner is personally responsible for all debts of the business.




	PDF The Elements of a Business Plan: First Steps for New Entrepreneurs
First, a business plan helps provide direction by making you discuss where you want to take the venture and define what you want out of it. Second, a business plan provides structure to your thinking and helps you make sure you've covered all of the important areas. Third, a business plan prompts you to think about the future.




	PDF Appendix 15 Sample Business Plan
Sample Business Plan Part I: The Business Purpose and Goals As we proceed through our business careers, it is vital that we set goals for the future. Although this is difficult and time consuming, the final reward is worth the effort. As you fill in the following, be as realistic as you can.




	PDF FILL-IN-THE-BLANKS BUSINESS PLAN OUTLINE
Step 2: Fill in the cost of goods sold for each month. Step 3: Calculate the Gross Margin for each month (Sales minus Cost of Goods Sold). Step 4: Fill in the total of labor-related operating expenses (salaries, mandatory benefits, optional benefits). Step 5: Fill in the total of non-labor-related operating expenses.




	How to write the structure and ownership section of my business plan?
Ready? Let's get started! What is the objective of the structure and ownership section of your business plan? The objective of this section is to provide potential investors, lenders, and strategic partners with a clear and transparent view of your business's legal form, ownership distribution, and registration details.




	PDF The FindLaw Guide to Starting a Business
Choosing a Legal Structure After writing a business plan, you will want to choose the structure of your business. Your choice of business structure is probably the first major legal decision you will make. Common choices for legal structures can include sole propri-etorships, partnerships, limited liability companies (LLCs), and corporations.




	Business Plan
1. Title Page The title page captures the legal information of the business, which includes the registered business name, physical address, phone number, email address, date, and the company logo. 2. Executive Summary




	Free PDF Business Plan Templates
These simple business plan PDF templates are ready to use and customizable to fit the needs of any organization. Simple Business Plan Template PDF This template contains a traditional business plan layout to help you map out each aspect, from a company overview to sales projections and a marketing strategy.




	Guide to Choosing a Legal Structure for Your Business
A business legal structure, also known as a business entity, is a government classification that regulates certain aspects of your business. On a federal level, your business legal...




	Creating a Business Plan
A business plan is not a legal document. It's a tool business owners use to increase the odds that their business will be a success. ... The legal structure of the business, intellectual property, and copyrights held; Financial plans and financial statements, such as financial projections, cash flow statements, balance sheets, income statements




	PDF Business Plan for a Startup or Existing Business
A business plan consists of a narrative description and financial projections. The narrative description is the body of the business plan. The sections of a business plan can be completed in any order you wish, except for the Executive Summary, which should be completed last but placed at the front of the document.




	How To Write A Business Plan (2024 Guide)
Describe Your Services or Products. The business plan should have a section that explains the services or products that you're offering. This is the part where you can also describe how they fit ...




	How to Create a Law Firm Business Plan
Download This Article as a PDF The first steps of starting your own law firm are crucial. A passion for practicing law is essential, but beyond that, you'll also need to know how to run the business side of your new firm.




	Drafting a business plan
Business planning confers several benefits to the firm, eg: •. increasing the likelihood of achieving the firm's objectives. •. demonstrating to others, eg banks, that the firm is moving forward. •. keeping management and staff focused. •. increasing the likelihood of recruiting and retaining talented staff.




	Legal Form of Organization in Business Plan
The legal form of organization in business plan is used to decide how the organization will function, how roles will be arranged and assigned, and how relationships will work. These organizational steps should take place at the beginning of the business formation. Starting a Business. The first step when beginning a business is to name the ...




	Business Plan Template in PDF
Business plan format. Each business plan is unique. Build your own plan by choosing the sections of a traditional business plan which suit your business and your needs. Here are the key segments to consider: 1. Executive summary: Make it easy for the reader by pulling out the key information in simple, impactful terms.




	PDF Business Plan
Legal structure Throwback Family Fun, LLC is a sole-owned Limited Liability Company in the name of Kelsey Redwine. It had been considered as a partnership with her husband, Peter, but with him as an employee and her as the owner, many more small-business grants are accessible. Shares are being offered through the SEC-exempt Registered Crowdfunding




	How to Write Your Law Firm Business Plan
19 Mar 2020 How to Write Your Law Firm Business Plan By Cari Twitchell Healthy Strategy Every new law practice needs a business plan. This is a guide to creating one. Here is what should go in your business plan once you've decided about your law firm business model. Section One: Executive Summary




	PDF Section 2.4 Business Organization: Structure And Issues
Easy to form, straightforward legal documents, less complicated than incorporation paperwork. Partners directly share in profits. Improved growth possibility. Easier to attract capital than in a sole proprietorship. Advantages Of Partnerships. Flexible, easier to execute decisions than a corporation but more difficult than a sole proprietorship.




	PDF Choosing the Best Legal Structure for Your Professional Practice
practice by creating a formal legal structure where none currently exists. If you have a business plan (see apapracticecentral.org/ business/management/tips/secure/business-plan.aspx), you should consider reviewing that document to see if you need to make any changes to your current practice model.




	PDF 1-10 Choosing a Business Structure
Choose a Business Name. You must follow these three rules: 1) it must be different from an existing LLC in your state, 2) it must indicate that it's an LLC or Limited Company, and 3) it must not include words restricted by your state (such as "bank" and "insurance"). File the Articles of Organization.




	Law Firm Business Plan Template [Updated 2024]
Written by Dave Lavinsky Law Firm Plan Over the past 20+ years, we have helped over 1,000 lawyers to create business plans to start and grow their law firms. On this page, we will first give you some background information with regards to the importance of business planning.




	Waterway works and structures
We pay our respects to the Aboriginal and Torres Strait Islander ancestors of this land, their spirits and their legacy. The foundations laid by these ancestors—our First Nations peoples—give strength, inspiration and courage to current and future generations towards creating a better Queensland.




	Create a form in Word that users can complete or print
Show the Developer tab. If the developer tab isn't displayed in the ribbon, see Show the Developer tab.. Open a template or use a blank document. To create a form in Word that others can fill out, start with a template or document and add content controls.




	Why a Small Business Cybersecurity Plan Should Be a Priority
2. Pick a legal business structure. Every business has a business structure. For example, some are sole proprietorships, partnerships, Limited Liability Companies (LLC) and Corporations. If you never formally apply for a business structure with the state, then your business is a sole proprietor (single owner) or general partnership (multiple ...
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